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Secrets of

Trading Platform
MetaTrader g

MetaTrader 4 Trading Platform

So many people uses MetaTrader4 trading platform,

but not so many really knows how to use it.
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. How to switch to the full-screen mode?
. How to promptly attach indicators, expert advisors and/or scripts to the

charts?

. How to get better positioning of the chart on the necessary time?

How to minimize "Terminal" window title bar?

How to create "Favorites" group with your frequently used
indicators/scripts/experts/accounts?

How to save traffic?
How to switch between several sets of symbols?
How to open the Popup prices window?

How to create the same Background and bars colors, indicators and objects
for all charts?

. How to create a special profile for each account?

. How to call the "Crosshair" object?

. How to check vertical distances and the amount of bars between two points?
. How to page through the chart bar by bar?

. How to display closed positions and deleted pending orders in the chart?

. How to easily place pending orders?

. How to easily modify Stop Loss and/or Take Profit2

. How to recover deleted object/chart?

. How to print a chart?

. How to set an alerting system?

. How to set an email messages alerting system?

. How to publish a report on FTP Server?

. Indicators

23.

How to attach indicators to a chart?

How to attach to the main window indicators that are opened in a
subwindow by default?

How to attach to subwindow indicators that are opened in the main window
by default?

Common properties of indicators attaching
How to build levels?

What is "visualization" tab?

File library in MetaEditor
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1. How to switch to the full-screen mode?

In order to switch to the full-screen mode you should press on F11.

g 276857: MetaTrader - Demo Account - [EURUSD,H1 | - |I:I|£|

File  “iew Insert Charts  Tool:  Window  Help |2 x|

EURUSDHL 1.2726 1.2735 1.2?;25 1.2732

T SN 1.
” IW¢+w+*++¢+++w”'“, W
i |

F1.2705

|
| 'ﬂ
LT |||||||||||||‘|||||||||i|||||||||H|‘ .
CCI(E) 41,8848

A \/ 7\ \/\/\ i ,

T Sep ZO0E 5 Sep 100§ Sep 200 6 Sep 0G0 E Sep 1400  E Sep 2200 7 Sep 000 7 Sep 140

219.2823

100

0.00

-100

204,299

In the full-screen mode, the following hotkeys can be used to open command windows:

= Ctrl+M - Market Watch
= Citrl+N - Navigator

= Ctrl+T - Terminal
Ctrl+D - Data window

To return to the normal mode, just press F11 again.
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2. How to promptly attach indicators, expert advisors and/or scripts to the charts?
Indicators, experts and/or scripts can be promptly attached to the chart if hotkeys are preliminarily set for
them.

This can be very useful in the full-screen mode. To assign hotkeys, select the "Set hotkey" option in the
"Navigator" window context menu:

&

MetaTrader

@ Accounts
-] Indicators
(- SF Expert Advisors
[%] Custom Indicators
E|‘ <'> Scripks
----- ] & dose
----- ] <'> delete_pending
----- ] = modify
----- <<> modify_pending | | | | | | | ‘ |
..... =0 —
_____ ] %, Rokate_t [igh Execute on Chart
----- 5 send_ped 4@ Modify Enter
""" < trade K Delete Delete
e Create Imzert
i, Addtofavorites
| Set hotkey h |
You can select any keys combinations you wish:
#* Mavigator Hot Keys ed |
WE= | Contral | (=0 |ﬂ Sek

£ Veqas_Currency_Daily

Reset |

fo Zerolagskachs

[ £] ZinZag Reset All |
fo _MTFCenterafiaravity-alerks

7 ahlina Ckrl k

fo user_ind

] + Period_corwerter Chrl 1

] <'> Riokake_kexk

] » close Al &

] <'> delete_pending
] <'> rodify
] <'> modify_pending

.
| I

=
L0 send pending
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3. How to get better positioning of the chart on the necessary time?
For better positioning of the chart on the necessary time, you can use the fast navigation line.

To open the fast navigation line, press the spacebar or Enter or move the cursor to the left bottom part of
the chart window and, after the sign appears, double-click with the left mouse button:

45 uma 4Sep 1000 &
CHF.5|
Double click, For editing

i 2 T6857: MetaTrader - Demo Account - [EURUSD,H1 - |EI|£|

File “iew Inzert Charttz  Toolz  ‘Window  Help == x|

EURUSDHL 1.2726 1.2735 1.2.'-":15 1.2719

MWII

F1.2845
F1.2825
1.2805
F1.27385
F1.276E
F1.2745

it

F1.2705

CCIE) -59.5638 2192527
100
.00

-100

% A ,,f
Y

2006.01.25 900 200  6Sep 0600 6 Sep 1400 £ Sep 220 7 Sep 0600 7 Sep 14400

-204.299

Do not forget to disable the chart auto scroll.
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Format of commands in the Fast Navigation line for precise positioning of the chart:

= [time (hours: minutes)]
example: 8:30

= [date]
example: 2004.10.16

= [date] [time]
example: 16.10.04 8:30

Using the fast navigation line, one can promptly switch between the chart's symbols and periods. This can
be very useful in the full-screen mode.

Format of commands in the Fast Navigation line for switching between symbols and/or periods of the
chart:

= [symbol name]
example: GBPUSD

= [chart period]
example: M30

= [symbol name],[chart period]
example: GBPUSD,M30

To execute a fast navigation command, press Enter. To cancel it, press Esc. Only one of the above
commands can be executed in the fast navigation line at a time.

4. How to minimize "Terminal" window title bar?

A double click with the left mouse button on the "Terminal" window title bar will minimize it to the bar of
the current account status.

Thus, some additional space will be free for the chart. You can also minimize the window by double-
clicking with the left mouse button on the title of any tab in the window.

To restore, double-click in the minimized window or select the "Restore" command in the context menu.

'W \»}HM V\/ New Dider F3

: T T T T i | ﬁestnre Double click
7 Sep 2006 F Sep23:1E 8 Sep 01:15 & Sep 03:1E 8 Sep 05:15 8 Sep 0F:15
ﬁase Ctrl+T

; | @ Balance: 5 278.80 ProfitfLoss: 0.00 Equitv: 5 278,80 Free margin: 5 273,80
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5. How to create "Favorites" group with your frequently used indicators, scripts,
expert advisors and/or accounts?

Frequently used indicators/scripts/experts/accounts can be added to the "Favorites" group to have a faster
access to them.

To do so, click with the right mouse button on the name of the indicator/script/expert/account and select
the command "Add to favorites":

Mavigakar -

_____ F) Frackals 9] | i CD}:lZ g /

----- [#] Gator Oscillator
..... (%] Ichimoku Kinko | "'
..... I ‘
_____ 71 Mark| [ Attach to a chart

..... [#] mam |1f'¢ &dd to favorites |

Common | Fay Set hntﬁgy

The listed items will be available in the "Favorites" tab of the "Navigator" window:

Mavigatar

‘% Maving Average
E}I ZigZag

) & period_converter
&} 409047 Johin Smith

| Common | Favortes [T
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6. How to save traffic?

The traffic can be saved if the unused symbols are hidden. The symbols can be hidden in a several ways:

1. Select the "Hide All' command in the context menu of the "Market Watch" window:

0 x
Symbaol | Bid | F\skl
4 EURUSD 1.2722 1.2725
4 GBPUSD 1.8732 1.8736
¥ ALDUSD 07568 0.7572
#» GBPCHF 23286 2,329
a USDIPY 116,21 116.24
4 ELRGEP 0.e7e0  0.6794

Hide Al .
Showdl
Symbaolz
Sets r
Highv/Low
Tirmne:
v Auto Arrange A
v Grid G
E Fopup Prices  F10

2. Select the symbol using the left mouse button and press Delete:

Market Wakch x
Symbol | Eid | Ask |
4 ELRUSD 1.2722 1,2725

Mew Order F3
& GEPCHF | Egh  Chart window
¥ USDIPY Tick Chart Space
¥ EURGEP
| Hide . Delet
Hide &1
Show Al
Symbolz
Setz 4
High/Low
Time
v Auto Arrange A
v Grid
E Fopup Prices F10
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Select the "Symbols" command in the context menu of the "Market Watch" window and hide/show
symbols in the window that appears:

E| Fore:x ;l Shie |

----- |§| AUDUSD {Australian Dollar ws LS Dollar
----- EURAUD {Euro vws Australian Dollar)

----- EURCHF {Eura ws Swiss Franc) Froperties |
..... EMELURGER (Eura ws Great Britain Pound )

----- EURIPY (Euro vs Japanese Yen)

..... [%] EURUSD (Eurc ws US Dollar

----- |§| GBPCHF ({Great Britain Pound vs Swiss Franc)

----- GBPIPY ({Great Britain Pound ws lapanese Yen)

----- |§| GEPUSD (Great Britain Pound ws LS Dollar)

----- GoOLD

----- USDCal {3 Dollar ws Canadian Dollar) b
----- USDCHF (US Dollar ws Swiss Franc)

----- |E S0Py {US Dollar vws Japanese Yen)
R hd Close

The symbol cannot be hidden if:

there are open positions or pending orders for this symbol
the chart has been opened within the current session
this symbol is used to recalculate cross rates

Traffic can also be saved if news are disabled. To do so, open the "Tools -> Options" menu and unflag the
"Enable news" field in the "Server" tab:

oprons 2 x|

Server |Chart$| I:Ibiec:tSI Trade | Expert Advisur&l Email I Puhli3h3r| Eventsl

Server: IMetaD uotes-Demo - Metalluotes Software Corp. j

Logir: |4E|53?2 FPazzword: In-uu Change |

Iv¥ Data Center auto configuration

Data Center: I Tjest |
[~ Enable prosy server Frow... |

¥ Keep personal settings and data at startup
[~ Ernable DDE server
Iw. Erable news

(] I OTtaeHa Cnpaek.a
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7. How to switch between several sets of symbols?
You can create several sets of symbols and switch between them, if necessary.

This can be very useful if you work with different groups of symbols (currency pairs, shares, futures, etc.).
Hide all "excessive" symbols and save the set obtained.

Market Watch x
Symbal | Bid | Bk, |
¥ ELRUSD 1.2715 1.2721
¥ GBPUSD 1.8718 1.8722
P ALDUSD 0.7566 0.7570
¥ GBPCHF 23275 23283
& JSDIPY 116.24 116.27
4 EURGEP 0.6793 0.6797

Hide All

Shiow Al

Symbols

Sets Save Az, [}J

Remove 4

High/Liow
Tirme Forex
v AutoArange A, Forexall

v  Grid G ‘ ‘ ‘
BB Fopup Prices F10 | |
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8. How to open the pop-up prices window?
The Popup prices window can be opened by pressing F10.

If you select "Always on the Top" in the context menu of this window, you will be able to watch quotes while

working with other applications:

Popup prices x|

12717 12720
15719 1.8723

ELIRUSD
GEPUSD

GBPCHF

| v .-f-.lwa_l,lstgn the Top

LISDIP
High//Low
Tirme
v Grid
Froperties...

Having selected "Properties..." in the context menu of the Popup prices window, you can adjust its colors

and fonts:

Popup-prices properties k

Fareground: Ii Elack, j Price Up: Ii Blue
Frice Dovan: Ii Red

Backaround: ||:| “w'hite j
Font: ITahn:lma j

¥ Custom size

¥ Show logo at the bottom

14

-

points

ak. I Cancel |
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9. How to create the same background and bars colors, indicators and objects for

all charts?

Background and bars colors, indicators and objects can be made the same for all charts. To do so, adjust
any chart as you wish: set colors, superpose objects, attach indicators, etc. Then select the "Charts >
Template = Save Template..." menu and save the obtained template as default.tpl

(g%
File  View Inzet Charts Tools  ‘Window Help =12 x|
EURLUSD MIS 12723 12723 12715 1.27 16!
! L1,2758
; Trading r
C] D : Erpert Advizors »
! ' I Indicators List Chl+| L
C] [JI] ' ' Objects List Chrl+B
l } ! Periodicity C [
' ?‘ '* : . | T emplate | Save lemplate...
20 Rehiesh Load Yémplate. . 12728
E Auto Arange Clrl+2, Rlemove Template
Grid Chl+G AD¥
i Wolumes Clrl+L BallingerE andz
i Q Zoorm [n + Defal 12705
L TS zemou Dinapol
: Fsz hl
m [E Save As Ficture.. Foml5
Sl Print Preview Layers
A2k Print... Chrl+P Momentum
7Sep 2006 7 Sep 2000 7 Sep 2200 8 Sep 00 Bl Propeties.. Fa My_tpl
Popular
Sample
Yolurne
Williarns

From this moment, the template will apply to all newly opened charts.

The following can be saved in a template:

= chart type and color
= colors
= chart scaling

= the presence of the OHLC line
=  the attached expert advisor and its parameters
= the superposed custom and technical indicators with their settings

= line studies
=  separators of days
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Specific templates can be created for charts opened from the Tester and for those opened independently.

To create a default template for charts opened from the Tester, you have to save the template as "tester.tpl"

R 406371: MetaTrader - Demo Account - [EURUSD,M5] — ol =]
File  View  Inzert  Charts Tool:  WwWindow  Help — =] =
EURUSDLME 1.2714 1.2715 1.2714 1.2715
testing with TakeProft=50; Lots=0.1; TrailingStop=30; MACDOpenLe‘uﬁl:l' MACD Clozelevel=2; MaTrendPeriod=26; l£ | 12735
| 1.2785
| 1.2775
MACDI(12,26,9) 0.00000 000002 000 ) 0.0001+
‘*--H_E_‘_ Lid:L s Cicaoit ST Heon
R e -0.00011
16 Aug 2006 16 Aug D6WS 16 Aug 06:45 16 Aug 07:25 16 Aug 0505 16 Aug 08:45 16 Aug 09:25 16 Aug 10:05 16 Aug 10:d5 16 Aug 11:2
=
Expert &dwvizor: IM.-'-\CD Sample LI | E=pert properties |
Symbal; IELIHLISD, Euro ws IS Dollar LI |M5 LI | Syrmbaol properties |
kM odel: IDpen prices only (fastest method to analyze thll Fecalculate [ | | Open chart N |
Use date [ From: |2DDE.DE.DEI vI To: I 1970.01.01 VI DptimizaLh\EDn [l
Wisual mode [ ] | Skip to |[2005 0508 ]
| Start |
Settings Results | Graph | Report | Journal |
For independent charts, the default template must be "offline.tpl".
Bl Open Offline Chart d e

Fram |

Tl:ulil

Hiskary Daka | Barsl
SEER.,M30 571
USDCHF, M1 7a9
USDCHF, MLS 570
USDCHR, M30 9562
USOZHF, H1 1541
USOCHF, H4 621
LISDCHF, Daily 537
LSDAPY, M1 29166
LSDAPY, M20 9133
USDaPY, H1 -1
YUEO, ME0 573
_MOCOMP,H1 707

ELRIISD,MS (Contral p... 55565
EURUSD,MS (Open prices) 11484
EURLSD,MS (E

20068,04.27 11:30
2006,06.22 03:15
2006.06.14 14:350
2005,10.20 17:00
2006,05.11 15:00
2006,02.22 00:00
2004,06.25 00:00
Z2006,06.01 00:01
2005, 10,20 1730
Z20068,03.13 16:00
20068,04.27 10:30
2005,09.20 2100
2006.05.11 02:10
2006,05.11 02:10

2006,08.21 15:30
2006,08.22 1739
2006,06.22 13:45
2006,07.25 12:30
2006,05.10 10:00
2006,07.17 05:00
2006,07.17 00:00
2006,07.26 15:3534
2006,07.17 14:30
2006,04.26 17:00
2006,08.21 16:30
2006,02.135 21:00
2006,09.05 0935
2006,09.05 093535

2006,09,05 15:35

Cancel

If the "offline.tpl" template is not found when the chart is opened independently, the "default.tpl" template is

used. On no "tester.tpl", the embedded settings are used.
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10. How to create a special profile for each account?

If you have several accounts, you can create a special profile for each. At switching between accounts, the
profiles will be opened automatically.

To create such a profile, you have to save it under the name which is exactly the same as the account
number:

i 106372: MetaTrader - Demo Account - [GBPUSD,M1 5]

File “iew Ingert Charts  Toolke  Window  Help

@"' ' —;{;‘; | %.New Order O ‘%

X = s #E AT % J_!_J:
Mext Profile

Previouz Profile Shift+F5

Mavigakar

% MetaTrader

E@ Accounts
...... & 406371: My _accountl ||%-[|g Save Profile As... |

...... - &) 406372: My_account? Remove Profils “S ¢
...... a 406373 My_accountd
...... - & 409047: John Smith Defaul
- [F] Indicators 406371
Ej---‘% Expert sdvisars v ANEI72
- | £ Custom Indicatars
[ L& SCripts 408373
Eritish Pound
Eura
FullScreen H1

Full5creen k15

b arket Dvervizw

kb
Common | Favorites |

Swiss Franc
Save profile as | 406372 | |

11. How to call the "Crosshair" object?

To call the "Crosshair" object, click the middle button of the mouse or press Cirl+F.

This can be very useful when working in the full-screen mode.
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12. How to check vertical distances and the amount of bars between two points?

You can check vertical distances and the amount of bars between two points using the ruler.

To do so, select the "Crosshair" object, click with the left mouse button on the first point in the chart and
drag the cursor to the second point:

i 40904 7: MetaTrader - Demo Account - [GEPUSD,M15] - |EI|£|
File “iew Ingert Chartz  Toolz  ‘Window Help -2 x|
[
=
l*+++l
hl H
L 12020
|+D' *
!*'l
P 157 § 18705 L8705
CCI(F) -97 6744 26,7332
\/\ 0,00
o M 100
234,733
7 Sep 2006 7 SofEUUNENERER G20 7 Sep 1130 7 Sep 1330 7 Sep 1530 7 Sep 1730 7 Sep 1930 7 Sep 2130 7 Sep 2230
P P P P P P P P

The first number (23) is the count of bars, the second number (157) is the vertical distance in pips, the third
number (1.8705) is the bid price in the second point.
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13. How to page through the chart bar by bar?

Use F12 to page through the chart bar by bar. This function can be very useful when you develop and test
your own trading strategy. Just open the chart at the very beginning of the history (press Home) and page
through it bar by bar.

i 40904 7: MetaTrader - Demo Account - [GEPUSD,M15] - |EI|£|
File  “iew Ingert | Chartz | Toolz  ‘Window Help -2 x|
i Indicators List Chrl+l
l.‘.+++l _ L 1.28E8
L l |] Objects L
F 12830
b D ' I, Bar Chart Al
Candlesticks Alts2 | 1,220
J  Line Chart A3
F1.87a0

Foreground Chart I |£ t l

F 1.5755

Perindicity b Hﬂﬂlﬁ]“‘u” I$+T++niﬂ¢++ﬂﬂ

Refiesh lm]

~
L
L 1.3705
I 49,6774 Grid Clrl+G 2067332
L Volumes Chil+L A A/\
. 100
[k, Auto Scroll
Chart Shift -
@% Zoom |n +
-100
) Zoom Out . M
[ Stepbysep . F12
L -234,733
7 Sep 2006 FSep07En | Lih Froperties.. Fa 7Sep 1530 7 Sep 17:30 7 Sep 1930 7 Sep2Li30 7 Sep 23:30

Shift+F12 will page through the chart backward.
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14. How to display closed positions and deleted pending orders in the chart?

Closed positions and deleted pending orders can be displayed in the chart.

To do so, go to the "Account History" tab in the "Terminal" window and drag the order to the chart using
the left mouse button. It is necessary that the symbol history of the selected order is downloaded from the
server. If the order is dragged to another symbol chart, it will be replaced with the selected symbol chart.

The order is displayed in the chart as order opening and closing/deleting arrows joined with a trend line
segment. Stop Loss and Take Profit levels are displayed in the vertical line with the open price.

B 276857: MetaTrader - Demo Account - [USDCHF,H1] -0l x|

File Wiew Inzert Charts  Tools  Window  Help =2 x|

JSDCHF,HL 11,2438 1,2440 1.2432 1.2428 !
: L1.2395

I- L1.2385
_I_ : d b1z

---------

_____

il
'I_ LB R : 5 L 1,2365

F1.23E5

F1.2345

h b g -

F1.2315

21 Jun 2006 21 Jun 04400 21 Jun 02:00 21 Jun 1200 21 Jun 1600 21 Jun 20000 22 Jun 0000 22 Jun 0chD0 22 Jun 0500 22 Jun 12400

Cirder i i i i Prafit
: Z006, ..., 45,50 S|
Ea 3885014 2006.... zell 0,10 usdchf 1,2354 | 0.0000 @ 1.2340 2006.... 1.2340 0,00 11.35 LI

E
(i
i

Account Histary | Mews | Alerts | Mailbox | Experts | Journal |

If Shift is pressed at the moment of dragging, all positions for the symbol of the selected order available in
the "Account History" tab will be displayed.
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15. How to easily place pending orders?

There is no need to remember conditions, on which the type of pending orders to be placed depends. Just
click with the right mouse button on the desired point in the chart where you would like to place the order
and select the "Trading" command in the context menu. You will see the types of pending orders that can
be placed in this selected point:

‘ 406372: MetaTrader - Demo Account - [GBPUSD,M15]

=10l x|

File View Insert Charts  Tool:  Window  Help =]
E 18785
T L 1.8775
] : I 1.8765
él H | Trading Mew Order F3
i 3
i Jr [;l I é] l l E=zpert Advisors | Bup Stop at[J\. 7R
‘ Periodicity b Sell Limit 1.6753
! L [ Template r T
E £ Refresh
: e] - L 1.5735
E * ’]-‘ E] Auta Arrange Chrl+A,
: I Gird Ctre G
' 1o Volumes Cl+L
: @% Zoom [ + 18715
'E% Zoorn Qut
: 13708
: |L_'[5| Save bz Picture. ..
7Sep 2006 7 Sep2liS 7 Sep 23S BSep OLUS 8 Sep O3 Print Praview 09:15
Ah Priet... Chrl+F
E-E, Properties. .. Fa

After one of the types has been selected, the window of order creation/modification with partly filled fields
will open. It just remains to specify Stop Loss and/or Take Profit values.

Chalk Up

Pending orders can be of four types:

= Buy Limit — the current price level is above the value of the order to be placed.
= Buy Stop — the current price level is below the value of the order to be placed.
= Sell Limit — the current price level is below the value of the order to be placed.
= Sell Stop — the current price level is above the value of the order to be placed.
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16. How to easily modify Stop Loss and/or Take Profit2

To modify Stop Loss and/or Take Profit, double-click on one of these fields in the order line.

* | order ¢ Tirne Type | Laks Syrbal Price SiL TIP Price Siap Prafit

Term

S| Trade | Account History | Mews | Alerts | Maibox | Journal |

After that, enter necessary values in the newly opened window.

Order #4207082 buy 0.10 lot EURUSD at 1.2718 sl: 0.0000 tp: 0.0000 - ||:||1|
ELRUSD: Symbol: |ELIRLISD, Euro ws 1S Dollar ¥
L.Eres Yolume: | 0,10 -
E EEEE Stop Loss: I 0.0000 3: Take Profit: I 0.0000 3:
Cormment:
1.2720
Twpe:
—Madify Crder

1.2716 Level: IS vI poinks Lewvel: |5 "'l poinks

L2714 Copy as: 1.2710 | Copy as;
L2712 Skop Loss: | 0.0000 3: Take Prafit:

12711 o e e 6
L2709 Stop Loss ar Take Prafit you set must differ From market price by at least 5 pips.
12707
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17. How to recover deleted object/chart?

NETWORK

If you have deleted an object by accident, press Ctrl+Z to undo:

Fg 406371: MetaTrader - Demo Account - [GEPUSD,H1 ]

File “iew Inzert

.¢unm+ﬁ1*

!m

I 1754190

6 Sep 2006 6 Sep 09:00

(G3)
| N F N

=10l =]
Charts | Toolz  “Window  Help 1= =]
Indicators List Ctrlel | ! !
| Objects Objects List Cil+B L L 1.6940
JL BEar Chart Alt+1 Delete Last Backspace ; | 1.2908
Candlesticks A2 |[F3  Delete All Selected Delete ;

Jr,  Line Char slit+3 | [l Delste All Amows e
Fareground Chart Unselect Al : | 2830
Perindicity b|# UndoDelete . Cil+Z :

g 1~} L.aa00
Template 4 : :

@ Refrezh + ! “- | 1.87e5
+ + i

Grid Chil+G 41[; T lq:'!"l":J +T! s L e

L, Wolumes Chil+L ; + ;

] B 1
Auta Scrall : : 13677
Chart Shift | |

; i oo
@% Zoom In + /\—/\",\J\m '

i 1o |{-100
Q Zoom Dut ' \\ '
Step by Step F12 ; 5

) R T

B2 Propertiss.. Fa 7 Sep 17:00 & Sep 01:00 & Sep 09:00

Charts closed by accident can be reopened with all their settings using the "File > Open Deleted":

i 406371: MetaTrader - Demo Account - [GBPUSD,H1

File | Wiewr Insert  Charts  Tools  ‘Window  Help
= [ist,  Mew Chart
I = Open Offline
+ | Open Deleted EURUSD
Profiles * USDCHF
Close Ctrl+F4 AUDUSD
Save As Cirl+5 GEBPUSD
|L_'[5 Save Az Picture... _NOCOMP
d?'. Open an Account \—|GEILD k_‘
% Login GEPCHF
EURJFY
Print Setup...
;, Print Prewview Rlemave g
d=h Print.. Ctrl+P
E it
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18. How to print a chart?

Press Ctrl+P to print out a chart. The chart is printed black and white by default, but it can also be printed
in color. Just check the "Color print" field in the "Charts" tab of the "Tools & Options" menu:

options 2|

Server Charts |I:Ibiec:t$| Trade I Ewpert .i‘-.dviscursl E mail I Publisherl Eventsl

V¥ Show trade levels

¥ Shaw OHLC

v Show ask line

¥ Show period separators
Is._ Color print

[ “Save deleted charts to reopen

b aw barz in hizton: IEEIDD vI
Max bars in chart: IEEIDD vI

(] I OrraeHa Cnpaeka

ler"u Mlﬂuﬂﬂiﬂ p i W *1#'121 “ :
[ 16
o e
R R AT
N
IIII!||||I|I||||||||||||I|Iil||unllllllhhulh.m...|I|II|||III|||.u.||||||||||||I|||||IIIqu|.u|||||||||||II||Iim...ll"" I|||||||!||I||||I!

TAOIOG  UAgIEND  ISplE0  (SpRO0  SSpLO0 SSpl00  SSpEO0  GepOd0 TSpl00  Fapddo
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19. How to set an alerting system?

System Events

Open the "Tools > Options" menu and go to the "Events" tab. By default, a WAV file is used to alert about
one of eleven events:
Zlx

Serverl Ehartsl Dbiectsl Trade I E:-:pert.-'l'l.dvisnrsl E mail | Publisher Ewvents |

¥ Enable

Ewvent

Action =

£\ Dizconnect dizconnect_ald. waw

:“lt Ernail Matify email. way

24 Timeout timeout. waw

200k ak.waw

‘& Mews NEWE, WaY e
L\ Ewpert Advizar epert, way

L\ Expert Confirmation | expert.way j

o |

OTreHa |

Cnpaeka |

These files can be found in the \MetaTrader 4\sounds\ directory of the Client Terminal. The alert can be
modified as desired. To do so, open the popup list in the "Action" column by double-clicking with the left

mouse button on the selected line:

Sewerl Chartsl Dbiectsl Trade | Expert.ﬁ.dvismsl Email I Publisher Ewvents |

d

v Enable
Event | Action -
" Connect cannect way

[\ Disconnect
43‘ E mail Matify
L0 Timeout

L3 Mews

L\ Expert Advisor

L\ Expert Confirmation

dizconnect_old.way
email. way

tirneout, way

ok.way
Cho =
alert way
alert2 wav
cannect way
connect_old way
disconnect way

digconnect_old. way
email. way
expert. way

[ =1 15 <

HEE.3

|_I*_

FIEWE. WAy
ok way
stopzway
tick. waw
tirneout, way

wiait ey

N 2T —>"

ED>XCFPERT ADWISOOR

NMNEURRAL METWOR




FORE><

EXXPERT ADWVISOR
NEURRARL NETWORK

The alert can be both a WAV file and an executable file ("EXE", "VBS", "BAT").

Mank.a: I ) sounds j € 1}' - mv
A alertz . way | email,wav | bimeout.way

ﬂ alert way j] experk.wawv ﬂ waik, waw

| conneck . way ) news. way

| connect_old.wav | ok.way

ﬂ disconneck, way j] stops.way

| disconnect_aold.way ) tick.wav

Hr4a akina: | OTEpETE I

Tun aiinoe: | Sound Files [ way) j OTraeHa |
| A

Sound Files [7.
Executable Files [*

Al Files [%.7])

If a file of another type is chosen for alerting, the application related to this file type will be launched. After
having selected an action, press Enter to confirm the choice. The event alert can be disabled by double-
clicking with the left mouse button on the line in the "Event" column.

User-Defined Events

Custom events can be of two types:

= the price reaches the pre-defined value for the desired symbol;
= the pre-defined timeout is reached.

Alert Editor ed |

@ To add a new or modify the existing alert please define all conditions and select the necessary ackion,

v Enatble

Ackion; IS:::unu:I j

Symbol: (5= lg Condition: I.ﬁ.sk:: YI Walue: II.ESEIEI

Mail
Source: |alert j |
Timeout: IE-EI sEC "’I Maxirmun iterations: |3 "’I

Ik I Test Cancel
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To set up alert, you have to go to the "Alerts" tab in the "Terminal" window and press Insert:

|z'_1 Create [ Inzert
T T T T T T T b odify o Enter
FSep 2006 F Sep 1400 F Sep 2200 8 Sep 0600 3 Sep 14000 8 Sep 22:00 11 Sep 0F:00

% | Symbal | Condition Counter | Limnik | Timneouk | Ewvent Delets Delete
L EURUSD Aisk=1,2800 0 1 10sec alert Enable On /O Space

L3 EURLSD Bid <1.2900 1 1 10 sec #LOGIMNE 2TIMES
o Alta Arange A

v Grd

Hill

)
C
E

Trade | Account History | Mews | Alerts | Mailbox | Experts | Journal |

Te

The alerts can be enabled/disabled by pressing Space, and modified by pressing Enter.

Alerts can be of three types: a sound alert, an executable file, an emailed message. For all alert types, it is
necessary to specify the "Symbol" and conditions (fields "Condition" and "Value"), at meeting of which the
alert will trigger. In the fields named "Timeout" and "Maximum iterations", it should be specified how many
times and with what regularity the alert will trigger.

Sound Alerts
Both files stored in the \MetaTrader 4\sounds\ directory of the Client Terminal and any other files can be

used as sound alerts: "WAV", "MP3", "WMI". If a file in the "MP3" or "WMI" format is chosen, the application
related to these file types will be launched at alert triggering.

Alert Editor ed

@ To add a new or modify the existing alert please define all conditions and select the necessary action.

¥ Enable

Ackion; IS:::unu:I j

Symbal: = lg Condition: I.ﬁ.sk} vI Yalue: II.ZEEIIZI

Mail
Source: |alert j |
Tirneouk: IEEI sEC "I Mazirmurn ikerations: |3 "’I

Ik I Test Cancel
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Executable Files

Executable files can be in formats of "EXE", "VBS", "BAT". If a file of any other format has been chosen, the
application related to these file types will be launched at alert triggering.

Alert Editor 2=l
Q To add a new or modify the existing alert please define all conditions and select the necessary action,

¥ Enable
Action: IFiIe "I
Swmbol; IEI_IRLISD VI Condition: | Time = VI Walue: Il?:IZIIZI

Bid <
Source: I diiprogram Files\metatrader 4imetaeditor exggg -

ask <
Timeout: IID seC 'I sk = rmurm ikerations: I 1 "I

(o] 4 I Test I Cancel i

20. How to set an email messages alerting system?

B

To get alert messages via email, it is necessary to make presetting in the "Email" tab of the "Tools 2>
Options" menu. Check the "Enable" field and enter your email server settings in the corresponding fields. In
each field, you can see red prompts about the data format to be entered.
= SMTP server — address of your mailing server when accessed via SMTP. Please do not forget to
specify the port number separated by a colon. It is usually port 25. Example: smtp.mail.com:25
= SMTP login — it is usually your email address. Example: your name@mail.com
= SMTP password — a password used to access to your mailbox.
= From: — you should enter the login ("Your name") and your email address on the same server, the
SMTP of which you would like to use. As a rule, the login coincides with the first part of the email
address, but it can be skipped. Example: your_name, your_name@mail.com
=  To: — email address you would like to send alerts to. The "Your name" part of the address can be
skipped. In general, the "To:" field should be filled out with any real email address. Example:
any_name, your_name@mail.com

options 21 x|

Sewerl Ehartsl Dbiectsl Trade I E=pert Advisors  Email |Publishel| Eventsl

¥ Enable

SMTF zerver: |smt|:u. mail. net

SKTP lagin: Iyour_name@mail. net

SMTP pazsword: I.............

From: Iyour_name, your_name@mail net

To Ian_l,l_name, ywour_name@mail. net

Test |

DKE I OTraeHa | Cnpagta
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Click on the "Test" button and check whether the message has been delivered to the email address you
have specified in the "To:" field. If all settings have been written correcily, the message: "Mail: Test
message' has been sent" must appear in the "Journal".

For sms messages to be sent, you have to specify the email address provided by your cellular operator in
the "To:" field. To use the operator's SMTP server as such, you have to verify its settings on the operator's
website or at the accounts department. Please keep in mind that not all cellular operators permit to use
their SMTP servers without calling to POP3 servers.

Then the alert as such can be created. To do so, press Insert in the "Alerts" tab in the "Terminal" window.
Fill out all the fields:

Q To add & new or maodify the existing alett please define al conditions and select the necessary action,

¥ Enable
Action: IMaiI j
Symibal; IELIRLISD j Condition: IBid:: *l Yalug: | 1.2900

Source: | #LOGIN #TIME#|n#SYMBOL# | #BIDH) #A5K#]

Tirneouk; |1III seC "l Mazirum ikerations: |1

K Test | Cancel |

!
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To create the message text, click on the J button near the "Source" line. Enter the subject and the body
of the message. Both in the subject and in the message body, you can use "Macros". The list of macros is
available from the context menu:

20|
Subject: I FLOGIMNA RTIME# Send |
#SYMEOL# ;l
#EID#
#ASH#E
I
G Undo Llt+B ackzpace
Pazte Chrl++
Select All Chrl-+a,
| t acra Symbol
Eid
Bzk, _I
High | =0 /J':
Lo
Login
Ealance
Frofit
kd argin
Trades

After this, click on the "Send" button.

Having filled out other fields, click on the "Test" button and check whether the alert has income at your
mailbox. If the message has been sent successfully, the corresponding record will appear in the "Journal":

* | Time Message

® 2006.09.13 15:5... | Mail: 'Test message’ has been sent

@ 2006,09.13 15:5... '276857": login {4.00, #20253C66)
@ 2006,09,13 15:5... MetaTrader 4.00 build 197 started

Trade | &ccounk History | Mews | Alerks | Mailbo | Journal
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21. How to publish a report on FTP Server?

The terminal allows publishing in internet reports about the account status on a periodic predetermined
base. For this, it is necessary to set up connection to the internet via FTP. Open the "Tools © Options" menu
and go to the "Publisher" tab.

The red color specifies the format to be used for entering the data.

options 2/ x|

Serverl Ehartsl Dbiectsl Trade I Expert .-’-'-.dvisu:ursl Email  Publisher I Eventsl

V¥ Enable
Account; |4EIES?1 Fiefresh eveny: Iﬂ minukes
FTP zerver: Iftp.metaquu:ltes.net mm F
FTP path: I.-"m_l,l_au:u:u:uunts 123 —
FTP logir: I_I,u:uur_ftp_h:ugin gg
240
FTP password: I-"'""'-'l 1440
[T Passive mode
Test

] I OTreHa Cnpaeka

The data transfer can be performed in either active or passive mode. The main difference between them is
the side that opens connection to transfer data. In the active mode, the FTP server initiates connection, and
in the passive one, the customer does.

Periodicity is the minimal time interval with which the report will be published. At that, if a trading position
or order changes in the terminal, the report will be forcedly and immediately published. This mechanism
provides data accuracy (except for the current market price and the profit) in the report.

After all settings have been made, click on the "Test" button. If the report has been successfully sent, the
corresponding line will appear in the "Journal".

Message

2006.09,13 16:03:10
@ 2006.09.13 16:03:07 | Publisher: starting
@ 2006.09.13 16:03:06 ‘276857 login (4,00, #29253C66)
@ 2006,09.13 16:03:04  MetaTrader 4,00 build 197 started

rminal

=]

Trade | &ccounk History | Mews | Aletks | Mailbox | Journal

T
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22. Indicators

No one can imagine the analysis of financial markets without technical indicators at the present time. You
can create your own indicators or use the embedded ones. The embedded indicators work faster than the
custom ones and have a number of features that cannot be implemented in custom indicators. For
example, there are indicators that can be attached to a chart both in the main window and in a sub
window. Besides, indicator can be calculated not on price and/or volume values, but on the values of
another indicator.

Clever use of the embedded indicators will help to go far without diving into programming the own ones.

There are thirty embedded indicators in the MetaTrader 4 Client Terminal. Conditionally, all indicators can
be divided into four groups:

= oscillators;

= trend indicators;

= Bill Williams' indicators;
= volumes.

Trend indicators help to allocate price movement in one direction and detect, synchronously or delayed,
the moments when trends turn. Oscillators allow detecting such turns synchronously or in advance. Bill
Williams' indicators have properties of both oscillators and trend indicators. Volumes analyze not the price
movements as they are, but the amount of ticks that have income during the bar.

Summary Table of Embedded Indicators Characteristics

Using the links in the table, you can view the code source of a custom indicator that corresponds with the
embedded one.

' Accepted Separate Assoc.lcn‘lon Additio | Period Apply MA Level
Indicator . Type / with nal /
Abbreviation . . . to Method
Main s/ m lines Shift
Acc.:eleruhc%n/Decele AC b s +/- i /- i i
ration Oscillator
Acc.umulohon/DlsTrl A/D v s +/- i /- i i
bution
Alligator Alligator b m -/+ - +/+ + +
Average Directional ADX ; s +/- i +/- n i
Movement Index
Average True ATR ° s +/- i +/- i i
Range
Awesome Oscillator AO b s +/- - -/- - -
Bears Power Bears o s +/- - +/- + -
Bollinger Bands BB t m +/+ + +/+ + -
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Bulls Power Bulls o s +/- - +/- +
Commodity CCl t s +/+ - +/- |+
Channel Index

DeMarker DeM o s +/- - +/- -
Envelopes Env o m +/+ + +/+ +
Force Index FRC o s +/- - +/- +
Fractals Fractals b m -/+ - -/- -
Gator Oscillator Gator b s +/- - +/+ +
Ichimoky Kinko Ichimoku o m -/+ - +/- -
Hyo

Market Facilitation BW MFI b s +/- i - i
Index

Momentum Momentum o s +/+ + +/- +
Money Flow Index MFI v s +/- - +/- -
Moving Average MA t m +/+ + +/+ +
Moving Average

Convergence/Diver MACD o s +/- - +/- +
gence

Mov.mq Average of OsMA o s +/- - +/- +
Oscillator

On Balance OBV v s +/- i /- +
Volume

Parabolic SAR Parabolic t m -/+ - +/- -
Relative Strength

Relative Strength RS| o s yn + +/- +
Index

Relative Vigor Index RVI o s +/- - +/- -
Standard Deviation StdDev t s +/+ + +/+ +
—Sfochushc Stochastic o s +/- - +/+ +
Oscillator

Volumes Volumes v s +/- - -/- -
Williams’ Percent %R ° s +/- i +/- i
Range

[l =1 1 5 <
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Table field descriptions

Type
= o - oscillator;
= t_trend indicator;
= b - Bill Williams' indicator;
=  v-—volume.

Separate/main

= s—indicator is attached in a sub window by default;
* m - indicator is attached in the main window by default.

Association with s/m: Whether the indicator can or not be associated with the indicator already attached in
a sub window (s) or in the main window (m).

Additional lines: Additional lines, Previous Indicator's Data and First Indicator's Data, appear in the "Apply
to" field in the indicator's properties window when the indicator is being dragged.

Cloze j

Cloze

Open

High

Lo

Median Price [HL/Z]
Typizal Price [HLC/3]
YWeighted Close [HLCC /4

Previouz Indicatar's D ata k

Firgt Indicator's D ata

Previous Indicator's Data - data of the latest indicator attached to the main window or to a sub window. If
there are no attached indicators, the Previous Indicator's Data are the chart data. And the indicator to be
attached will be built based on the Close price of the chart.

First Indicator’s Data - data of the indicator that was attached as the first to the main window or to a sub
window. If there are no attached indicators, the First Indicator's Data are the chart data. And the indicator
to be attached will be built based on the Close price of the chart.

[ =1 15 <

EXCFPERT ADWISOR
NEURRAL NMETWOR K




FORE><

®
N AT =" FNEFNT

EXXPERT ADWVISOR
NEURAL NETWORK

Period/shift: Availability of fields with corresponding names in the "Parameters" tab of the indicator's
properties window.

Farameters |Levels| "-.J'isualizatil:nnl

Period: |E Shift; |n

P& method: I Simple j

Apply to; I Cloze j

Style: Ii Blue j I j I j
k. I OTreHa | Reszet |

Apply to: Availability of the "Apply to" field in the "Parameters" tab of the indicator's properties window.

Parameters |Levels| \:"isualizatiunl

Period: |33 Shift; IU

F& rethod: ISimpIe j
Apply to; | Close j
Cloze
Style: Ii Blue j Epin
ig
Lo

kMedian Price [HL/2]
Typizal Price [HLC/3]
“Weighted Cloze [HLCC/4)

o I

MA Method: Availability of the field of the same name in the "Parameters" tab (choice of moving average
building method).

Levels: Availability of the "Levels" tab.
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23. How to attach indicators to a chart?
An indicator can be attached to a chart in six ways:

= uysing the main menu command:

k@ 276857: MetaTrader - Demo Account - [EURUSD,H1 ]

File  “iew | Ihgert| Charts  Tool:  ‘Window  Help
EURLUZD,H1 1-2?4| Indicators Caommodity Channel Index
. Accelerator Ozcillator
Lines 4
Accumulation/Distribution
Channels 4
Alligatar
Fann 4 o
. . Average Directional Movement [ndex
Fibonacci 4
Average True Range
Shapes 4 J 5
Alrows 4 Trend Commaodity Channel Index
) Ozcillators 4 Average Directional Movement [ndex
s Andrews' Fitchfork,
. . Wolumes 4 Bollinger B ands
|||| Cucle Lines
Bill *illiamz 4 Moving Average
A Text g g &5
e Cuztam 4 FParabolic 548
iT:  TextLabel :
ol I” !'1-' I Standard Deviation
1 I .

= using button Eﬂ'v

@ 276857: MetaTrader - Demo Account - [EURUSD,H1]

File “iew Insert Charts Toolk ‘Window Help

Lo slaalelik|E 0 =

EURUSD,H1 1.2741 12757 1.2727 1.2733 Commodity Channel Index

Accelerator Ozcillator
Accumulation/Distribution

Alligator

feverage Direchional Movement Index

foverage True Range

Trend +
Ozcillators L4
Walurmes L4
| Bill *##illiamsz Accelerator Ozcillator
Cusgtom 3 ‘ Alligator

I
Awezome Oszcillator a3

|+ I
lmﬂ IHTHIUJ’ [JIHDHM Fractals

Gator Dzcillator

l{l +¢ M arket Facilitation Index
Nnr &
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= double-clicking on the indicator name in the "Navigator" window;
= selecting the "Navigator" window context menu command:

[ MetaTrader

@] Accounts

L——_I? Indicators

----- £ Accelerator Oscillakor

..... F | Accurnulation) Distribution
..... £ aligator

| &verage Directional Movement Index

----- £ Ave|lig  Attach to a chart

----- F £ .
= A T2 Addtofavortes

..... ¥ Bea

_____ T Boll Set hotkey

= using the preset hot keys;
= dragging the indicator with the mouse into the main window or into the other indicator's sub
window (drag-and-drop).

Mavigator x *U ' T’u '
% MetaTrader -
: Accounts

£ F | Indicators
— MACD12,26,9) -0.00050 TR
----- | £ Accelerator Oscillat -1

=
=

..... [ Accumulation)Cistril 171
..... | alligator

..... ¥ Average Directiona
..... | Average True Rang

..... | Awesome Oscillator
..... |£| Bears Power

M Eclinger Bands

..... 7 Bulls Pawer ||z aprzooe s Apr 1300 28 Apr:

Common | Favorites | EURLISD,HL GEFUSDLHL |

The first five ways do not differ from each other fundamentally. Let us call them default modes of indicator
attaching. At this, the indicator will be drawn either in the chart or in a separate sub window, as by default.
The fifth method, the dragging, is more interesting. Some indicators, when dragged into the chart, can be
calculated from values of another indicator already attached to the chart. There are seven "special
indicators:

= Bollinger Bands;

= Commodity Channel Index;
=  Envelopes;

=  Momentum;
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= Moving Average;
= Relative Strength Index;
=  Standard Deviation.

Embedded indicators can be combined with other indicators or calculated on values of other indicators. At
combining, the indicator to be attached is just displayed over the indicator already attached, but has its
own scale and borders. In this case, the values of the indicator to be attached are calculated from the
chart price values.

An embedded indicator that is displayed in a sub window by default can be combined with the indicator
already attached in the sub window. An embedded indicator that is displayed in the main window by
default can be combined with the indicator already attached in the main window.

Most embedded indicators can only be attached as in the default mode. Those seven "special" indicators
can be attached both to the main window and to a sub window.

24. How to attach to the main window indicators that are opened in a sub window
by default?

Indicators below are opened in a sub window by default:

=  Commodity Channel Index
=  Momentum

= Relative Strength Index

= Standard Deviation

Let us study properties of these indicators by the example of Commodity Channel Index. As it was already
mentioned above, this indicator will be opened in a separate window by default:

BN 276857: MetaTrader - Demo Account - [EURUSD,H1] N - o] =]

Wiew Insert Charts  Tools  ‘Window  Help ===

or

| MetaTrader i L 12830

m&g Aooounts }]
= ’h Indicators Iu* l

| %

F1.2815
i | Accelerator Oscillabo

..... [#] ‘accurulation; Distrit lJT] [ﬁI ﬁ* [

..... [#] alligatar +l H H

..... [¥] Average Directional | 4]* i l s
¥ pverage True Range

..... [F1 fuwesome Oscillator IJ'] =

..... [ Bears Power T

..... [#] Bollinger Bands : L F1.E7ES
[ 7] Bulls Power Ij][;]q{i] I.I.*[] *H]*HIT |-

..... [F] [Zommadity Channel Tndex|

..... [¥] DemMarker
----- [F1 Ervelopes F1.2725
, Farce Index CCIF - 120,8633 s 1E 2,
..... { Fractals l",| o II! .\-*I ||:III r
----- f } W |l-rf \."Jrl ! l'_' ‘,r'l
- Gator Oscillator | ] 1 FEeS ! \.,J y f! 0.00
..... # | Ichimoky Kinka Hyo 1 il |I i i \
= l i T e O | s
-[7) macp Lyt bzEgng .’f [ L
..... F| Market Facilitation Ir 4 & Wk
= - "v'J 241.507

Common | Favorites | 22 Sep 2006 22 Sep 13100 25 Sep 0200 25 Sep 1100 25 Sep 19:00 26 Sep 03:00
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To attach CCl to the main window, one has to drag it to the chart. The indicator's properties will look as

given below:

Commod hannel Index

Parameters | Levelsl '\-"isualizatinnl

d

Period: I?

Apply ta: | Cloze j
Cloze
Shyle: I. LightSeabieen "I Open
High
. - Lowe
Fised riimurn [~ |1 Median Frice [HL/Z]
Tupizal Price [HLC/3)

= “Wieighted Cloze [HLCC/4

First Indicator's Data

Actually, the chart is at the same time the indicator. So, if no other indicators are available, First Indicator's
Data and Previous Indicator's Data - are data of the chart itself, and the drawing method on the previous
indicator's values does not differ from that on the first indicator's values in any way.

Thus, to attach indicator into the chart window, one has to drag-and-drop it to the chart and select First
Indicator's Data or Previous Indicator's Data. The obtained result:

) il x
i ile Wiew Inzert Charts Toolz  Window  Help =121 =]
[Navigator * oot -127.2727 153,330

5 MetaTrader = A [Fesie
+rﬂ accounts e
'—] # Indicators i lII j =
: .r fccelerator Oscillako ﬁ | I', | | _11002315
..... { AccumulationDistrib I ,fm | I
----- F alligator | X
----- [F] average Directional | I|,III I=|I I,'I| [ﬁl? | y (g .
[F] average True Range i) | } | | _.'f"‘r_ | I". |'I|| L 12795
----- [Fl awesame Oscillator I J[ ¥ ) | II\ 2 0.00
..... ¥ Bears Power | ! e]ir?l i ,II II ( by || | | 12785
----- 1-‘ Eollinger Bands | i: | ,'I !' .I I||I
.r Bulls Pawer i || I| - \, { || 12775
----- [F! commodity Channel = Iy | / \‘*, |
----- [F] DeMarker f J'I Il i Eg ﬁ i i
= -\‘\, [ ! LW H I -100
..... F| Envelopes .’I | / | i l
1 F) Force Index L‘ | | ,-"I ‘ | I;]? H 5 B8R
..... [F! Fractals I| l-"r | ;] l |] ““
..... [#] sator oscillatar | * i
..... [F1 tehirmoku Kinko Hya
7] maco
..... (] Market Faciliation Ir e
... [ b -2d1 507
Common | Favorikes | 22 Sep 2006 22 Sep 1300 25 Sep 0300 25 Sep 1100 25 Sep 1900 26 Sep 03:00

Indicators Momentum, Relative Strength Index and Standard Deviation are attached to the chart window in

the same way.
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25. How to attach sub window indicators that are opened in the main window by
default?

Indicators of this group are listed below:

= Bollinger Bands;
=  Envelopes;
=  Moving Average.

Let us consider Moving Average as an example. By default, this indicator looks as follows:

B 276857: MetaTrader - Demo Account - [EURUSD,H1] =10 x|

File  “iew Ingert Charts Tools  ‘Window Help == x|
- 1.26840

EURUSD,HL 12741 12757 1.2727 1.2734

F1.2825
L1.2810
F1.2795
F1.2780

Moving Average (5

Tirne: 2006,09,25 00:00

Yalue: 1.27385

T TLI_| | ‘ ‘ F 1.2765

L 1.2750

F 12720

F1.2705

21 Sep 2006 21 Sep 19:00 22 Sep 02:00 22 Sep 11:00 22 Sep 19:00 2€ Sep 0400 25 Sep 12:00 2€ Sep 20:00 26 Sep 04:00

Attachment of the MA to a separate sub window, it is necessary to make some more actions than for the
previous example.
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First of all, a separate window must be "created". For this, let us attach to the chart any indicator that can
be opened in a sub window. For example, MACD:

i 2 T6857: MetaTrader - Demo Account - [EURUSD,H1 ] - |EI|5|
File  “iew Ingert Charts Tools  ‘Window Help == x|

EURLUSD,HL 1.2741 12757 1.2727 1.2732

%lﬂm “ ﬂﬁ’m\
ot My y

: Lo
| T Lﬁﬁ]m?ill*ﬂl**?*”lT s
A

F1.2705
MACDI12,26,9] -0.00090 0,008 0.00237

21 Sep 2006 21 Sep 19:00 22 Sep 02:00 22 Sep 11:00 22 Sep 19:00 2€ Sep 0400 25 Sep 12:00 2€ Sep 20:00 26 Sep 04:00

=

a0

-0.00129

Now, we can drag the Moving Average into the MACD window and select Previous Indicator's Data or First

Indicator's Data in the properties window (since there is only one indicator in the sub window, the MACD, it
will be both the first and the last indicator).
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When a number of indicators are attached to one sub window, it is always possible to detect, which of
them on which is built. Selection of Previous Indicator's Data is displayed as ">", that of First Indicator's
Data - as "=>".

=Tk

B File Wiew Incert Charts  Tods  Wikdow  Help == x]
* || EURUSDLHL 12741 1,2757 1.2727 1.2732
----- ¥ Force Index - E—
----- [ Fractals + ﬁ
..... [ Gator Oscillator H lu* I‘ | ﬁlﬁ*lﬁ
----- ) 1chir pym— 7 ke
_____ PR Moving Average 21 x|
----- [ Marl Parameters | Levelsl "v"isualizatju:unl l r1.2785
..... 71 Mon T
..... _fq Mon Period: |5_ Shift: |El_ IJ-1.2?55
..... [ Mo
..... [F] Maw ks method: |Simple ;I e
..... [F] ont
..... ) pare Apply b |Elase ;I 12752 |
[El gal: Cloze L1.2728
B S —
..... [F star Loy — L 1.2708
..... = 0| Median Price [HL/2] J -
== Tuepical Price [HLCA3)
..... F ool wieighted Claze [HLCC/4) —
B RS Prewvious Inu:liu:atr's Data
: First Indicator's Data
Ej—--% Expert Advisors
- % Cuskaom Indicators
[ L&y Scripts (Ll ‘ ‘ | | | | |
- r 1 %Hhoz
]ﬂl Favorites | 21 Sep 2006 21 Sep 19:00 22 Sep 03:00 22 Sep 1100 22 Sep 19:00 25 Sep 0400 25 Sep 12:0
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B 276857 MetaTrader - Demo Account - [EURUSD,HL] N o (=
i'.

“iew Inset  Chatz  Toolz  Window Help =5 =i

5 % || EURLISDHL 12741 12757 1.2727 1.2734
----- [F] Faorce Index ;]

= + 12820
..... £ Fractals u

----- [F | Gakor Oscillakar

J Ichimoku Kinko Hyo HJ'JIHUL[:]TTHD

_____ 7l mMaco
----- [¥] Market Facilitation Ir 1'
----- [# Mamenturn 4 270
- [F] Maoney Flow Index

7] Moving Aversge UWDW | Lizas

..... j | Moving Awverage of ¢ |] l'j j_*
----- £ On Balance Yalume F12710
. [F| Parabalic 587 ‘L.I.I:] ﬂ T
..... (¥ Relative Strength In U ! T.L H] H1.268s
----- .f: Relative Yigor Index Ll:]d]
----- [#] standard Deviation [ 1.2665
" | Stochastic Oscilstor MACD(12,26,9) -0.0008% -0.00057 ==MA(S) -0.00052 000233
..... £ Yolumes
-.[F] williams' Percent Rar
= “?8 Expert Adwisors
- .E;. Custorn Indicators
[ L Scripks L 0,00
=
-0,00041
]ﬂl Favorites | 20Sep 2006 20 Sep 2100 21 Sep 0500 21Sep 1300 21Sep 2100 22 Sep 05:00 22 Sep 13:0

We have obtained MACD with Moving Average superimposed on it. We can stop at this, but we can also
do so that only Moving Average will remain in the window. To do so, it is necessary to remove MACD. But,
if we just remove it, the Moving Average, as indicator built on the MACD values, will be removed, as well.
So, let us detach Moving Average from MACD first. Let us calculate on, for example, Close values.

Farameters |Levels| "-.J'isualizatil:nnl

Period: |5 Shift: ID
M method: [Simple =]
Apply to: IFirst Indicator's Data j
Style: Ii Blue j E::Enlin %
Lo —
o Median Price [HL/2] J
Typizal Price [HLC/3]
WWeighted Closze [HLCC/4) -
Frevious Indicator's Data
First Indicator's D ata
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Now, the MACD can be removed, the Moving Average will remain in the separate window.

i 276857: MetaTrader - Demo Account - [EURUSD,H1] - |I:I|£|
File View Insert Charts  Tool:  Window  Help =] x|

EURUSE,H1 1.2741 12757 1.2727 1.2731

F1.2820

Tl

L

lJI] L 1,2500

n$|++nl¢f?¢+m +$+l¢ﬁ++iﬂﬁ ll
g

F1.2755

F1.2710

TIJ']*[JI] F1.2685

F1.2665

Maoving Average (50
Tirne: 2006,09,22 02:00
Yalue: 1.27905

20 Sep 2006 20 Sep 21:00 21 Sep 05:00 21 Sep 13:00 21 Sep 21:00 #2 Sep 05:00 22 Sep 13:00 22 Sep 21:00 25 Sep 0600 25 Sep 1440

Thus, combining properties of different indicators, one can build a rather complicated system.

[ =1 15 <

EXCFPERT ADWISOR
NEURRAL NMETWOR K




FORE><

®
N AT =" FNEFNT

EXXPERT ADWVISOR
NEURAL NETWORK

26. Common properties of indicators attaching

= |fthe indicator to be attached is calculated on values of the indicator that has several lines (more
than one), it will be calculated on values of zero line or the main line. In the code, this line is
detected using values of the first parameter of the SetindexStyle function. So, for example, if the
indicator to be attached is calculated on the MACD, the histogram values will be taken as the
values for calculations since it is determined in the MACD code: SetIndexStyle (O,
DRAW_HISTOGRAM).

=  Many indicators have, by default, fixed maximum and minimum, for example, RSI has. In this
case, after it has been attached to another indicator, for example, MACD, their borders can
misalign, i.e., RSI just will not match the MACD window.

MACDI1Z,26,4) 000053 -0,00088 ==RSI(14) 28 50148 0.00234
R L HH‘||||| ||||| 0.0

| -0.00059

20 Sep 2006 20 Sep 2300 21 Sep 07:00 21 Sep 15:00 21 Sep 2300 22 Sep 0F:00 22 Sep 15:00 25 Sep 00:00 25 Sep 03:00 25 Sep 16:0

To correct this, it is necessary to uncheck the fields of maximum and minimum, and the indicators'
scales will be independent on each other.

Relative Strength Index e S

Parameters | Levelsl Visualizatiunl

Period: |1 4

Apply to: IFirstlndicatDr's Diata j
syle: [B Medimiichid v| [——— =] [——— =]
Fixed rinirmurm %I-UUUUEE‘ Fixed masimum [ IU.UU233?

aE. I OTtrieHa | Reset |

MACDI12,26,9) -0,00100 -0,00058 ==RSI(14) 2529611 0.00233
70
0,00
RERRNERNNA
oozt
19 Sep 2006 20 Sep 05:00 20 Sep 13:00 20 Sep 2100 21 Sep 05:00 21 Sep 13:00 21 Sep 2100 22 Sep 05:00 22 Sep 13:00 22 Sep 21:0
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= When a number of indicators are attached to one sub window, it is always possible to detect,
which of them on which is built. Selection of Previous Indicator's Data is displayed as "->", that of
First Indicator's Data - as "=>".

MACDI12,26,9) -0.00118 -0,00091 ==Ma

,I T L
W'mnm W’ [l

m‘., @

T
‘il! 100

0.00137

0.00
-100
30

-0L000E7

-

30 S&ug 2006 I3IZI g 2200 I31 g 0600 I31 fug 1400 31 g 2200 1 Sep OB:00

Sep 100 1 Sep Z2:0 4 Sep 0700

4 Sep 1500

In the above example, the indicators are built in the following way:

attached MACD;
calculated MA on the First Indicator's Data, i.e., on values of the MACD;

calculated RSI on the First Indicator's Data, i.e., again on values of the MACD;
combined CCI with MACD;

calculated Momentum on the Previous Indicator's Data, i.e., on values of the CCI.

o wN -

=  Embedded indicators can be superposed onto not only other embedded indicators, but also onto
custom indicators. The attaching principles are the same. For example:

Drrivel1E) 49688 7 4063 -=MAIE) 51875

126047

4.1141

20 Sep 2006 20 Sep 22:00 21 Sep 07:00 21 Sep 15:00 21 Sep 23:00 #2 Sep 07:00 22 Sep 15:00 2€ Sep 00:00 25 Sep 02:00 25 Sep 1640
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27. How to build levels?

Some indicators allow building of levels. For MA, one can build a channel using levels. To do so, it is
necessary to go to the "Levels" tab and set some values using the "Add" button.

Parameters  Lewels | "-.J'isualizatil:nnl

Lewvel | D escription | Add o |
14 Lewvel 1 bl

Shple: ||:| Silver j I j I j
k. I OTreHa | Reszet |

Parameters |Levels| \:"isualizatianl

Periad: |5 Shift: ID

P& method: I Simple j

Apply ta: I Cloze j

Style: [ white | =l =l
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Now, if we make the MA line colored the same as the background, we will obtain channel built on the
moving average.

i 2 T6857: MetaTrader - Demo Account - [EURUSD,H1] - |EI|5|

File View Insert Charts  Tool:  Window  Help =] x|
F 12840
EURUSD HI 1.2711 1.2714 1.2710 1.2714

’l‘é]r F1.2828

F1.2810
F1.2795

1 F1.27a0

RSN
Yl

LW‘ $¢ HD *T N

J|f|ﬂ], |

¥ s

0

[ 1.2705

1 Sep 2006 21 Sep 20:00 22 Sep 000 22 Sep 12:00 22 Sep 200 25 Sep US:00 25 Sep 13:00 25 Sep 21:00 26 Sep 05:00
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28. What is "visualization" tab?

In the end, let us consider one more property of indicators in the MetaTrader 4 Client Terminal. All
indicators, both embedded and custom ones, have this property. Moreover, it can apply to objects, as well,
i.e., to graphical and technical analytical tools.

There is no secret that data analyzed on different timeframes of the same symbol can differ. Different
technical tools can be used, including different indicators with different settings. The following can be done
in order not to re-adjust indicators again and again when switching between timeframes: Specify in the
indicator properties window that timeframe, to which the selected indicator will be anchored.

F'arametersl Levels Wisualization |

[ alltimeframes

v M1 [~ M0 [ Daily
[ M5 [~ H1 ™ weekly
I M15 [ H4 ™ Morithly
F%smw in the Data Window

k. I OTrEHa FRezet

And so on for all indicators and on all timeframes. In future, when switching between them, we will be
able to see different indicators on different timeframes. It remains just to save the template to be used in
future for other symbols.

Example: On timeframes of H1 and M15, the same indicators, MACD and MA, are attached, but with
different periods.

= On H1: MACD with values of 12, 26, 9; MA with the period of 7 is calculated on the MACD; MA
with the period of 5 is calculated on the MA(7).

= On M15: MACD with values of 24, 52, 18; MA with the period of 28 is calculated on the MACD;
MA with the period of 20 is calculated on the MA(28).
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=T
File  “iew Ingett Charts  Toolz  ‘“Window Help - 2] x]
EURLISD,HL 1.2711 1.2717 1.2710 1.271E tesss |
Hpinet| -

TMHWF [lﬁ*'ﬂ T 'ﬁ'ﬂl 12855 s

l
. !ITM' Ti“" +|I il |:| “#' 1zgoc | MIE
HﬁhTﬁﬂllll“* H “ H'““ ' ﬂ * +‘ (e
1.2795
| i £
‘ 12765 H4

|
|‘mm+hlw'ui+“ Q ‘T*

531
w1
'Y MM
”M [ 1.2675
1.2645
M&CO(12,26,9) -0.0012 =MAF] -0.00091 -=MAS) -0,00083 0.00145
TS e
Iy II_M#W g s "”\H HHHH |
I -0.00234
1Sep 2006 15ep 16:00 4 Sep 09:00 G Sep 01:00 G Sep 1700 6 Sep 09:00 7 Sep 0100 7 Sep 1700 & Sep 09:00
i@ 276857: MetaTrader - Demo Account - [EURUSD,M15] — |I:I|i|
File “iew Inset Charts Took  window  Help =15 x|
ELRUSDMIS 12716 1.2717 12715 12716 12675 Ml
L2860 MS
JJ ﬂ'l 'HI h:IHI ' “Hi l‘ “I Mis
h ~ {nlu 12645
+H M30
M fint
ﬁ' '+u1l:l l? r 1.2830 ™
Hl TT'I]" 12815 H4
iy
thl':' T rzaon Ot
i1
1.2785
P
“ OY 1.2770
1.2755
MACDI24,52,15] -0,00078 -0,00038 ==MA(28] -0,00037 -=MA(20] -0,00039 HHHHH . 0.00129
HHH| H”H””‘|||||||||||||”|||I ..... 11l IIIIIIII|||||||| |I|||||||||HHHH HHH|||H|| n.00
-0.00106
1 Sep 2006 1 Sep 000 1 Sep 02:00 1 Sep 12:00 1 Sep 16:00 1 Sep 20:00 -IflSep 01:00 l1Sep 05:00 -IflSep 03:00
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29. File library in MetaEditor

Files

AL

NETWO

RK

All MQL4 programs are available through the "File - Open" menu or through the toolbar. For more
convenient access to MQL4 programs, there is a "Files" tab in the "Navigator" window.

In this tab, all MQL4 programs are displayed that stored in the "\MetaTrader 4\experts\" folder or in one

of its subfolders.

The following actions are available from context menu of this tab:

MNavigator

@ Files
1 config
0 Files
1 inchude
1 indicatars
71 libraries
1 logs
0 presets
] samples
-1 scripks
0 templates
|
Marving A Mew File...

[E

Enter

Mew Folder...
= Open
K Delete
Refresh
S &I
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. New File... — creation of an empty file with
extension MQ4. The file will be created in the folder
selected at the moment of the file creation. To create a
file in the "\MetaTrader 4\experts\" folder, one has to
select the root word "Files".

= New Folder... — creation of a subfolder in
any of the selected folders. To create a folder in
"\MetaTrader 4\experts\", one has to select the root
word "Files".

= Open — open the code of the selected
program in a separate window of MetaEditor.

. Delete — deletion of the selected file or
folder.
. Refresh — refreshing of the program list,

synchronization with the "\MetaTrader 4\experts\"
folder.

= Show All — show/hide files of all types. By
default, only files having extensions of MQ4, MQH,
MQT are displayed in the "Files".
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Library

If you have not found a program in the file list of the "Navigator" window, you can download it from our
website. You do not need to open your browser to search in the website and download. You can get a
quick access to all desired programs using MetaEditor. Just open the "Online Library" in the "Toolbox"
window.

E2 Refresh & Experts Indicators S Scripts : Libraries ‘i\._ Articles @ ML, cam trend| A H
Mame Description Date Author

@ Perkydsctrendl Indicator Perkyfsctrendl, as well as all other ASCTrend indicators is based on Laryy william..,  2008.10,16 Collector
@ Ichimoku Kinke Hya, Ishinaoka Ichirmoky Kinko Hyo Technical Indicator is predefined ko characterize the market krend, supp...  2006.09.07 MetaQuotes
@ alkrTrend_Signal_wz_2 Indicator that signals about trend kurns. 2006.08.11 Collector
@ Keltner Channel The Keltner Channel indicator locates the maost important brends, 2006.07.13 Collector
@ {Trend iTrend Indicator determines where the trend starts and ends. 2006.07.13 Collector
@ Maoving Awverage ConvergencefD...  Moving Average Convergence/Divergence (MACD) is the next trend-Following dvnaniic indic,..  2006.07.12 MetaQuotes
@ Parabolic SAR, Parabolic Parabolic SAR Indicator was developed for analvzing the trending markets, 2006.07.12 Metauotes
@ Awerage Directional Mowvement I... | Awerage Directional Movement Index Indicator (A0%) helps to determine if there is a price £... | 2006.07.12 MetaQuotes
@ Detrended Price Osillakor Detrended Price Oscillator 2006.07,12 Collector
@ aroon Oscillakar The oscillakar quickly finds out the trend stop and the start of sideways trend in horizontal ... | 2006.07.11 Collectar
@ 3LineBreak Indicator that colors bull trend bars blue, and bear trend bars red. 2006,07,11 Collector
@ 3D Oscilator Qscillator that signals about trend turn, When the blue line meets the red one top-down, 5... | 2006.07.11 Collector
@ Bears Power, Bears Bears power oscillator (Bears Power, Bears) - trend Following indicator, 2006,05,31 IMetaQuotes
@ Bulls Power, Bulls Bulls power oscillator (Bulls Power, Bulls) - trend Follawing indicatar, 2006.05,31 Metauotes
@ Strategy Tester: Modes of Mode...  Many programs of technical analysis allow to test trading strategies on history data. Inthe ... 2005.09.13 MetaQuotes

Errors | Findin Files | ©nline Library | Help |

If one of the following pages - "Experts | Indicators | Scripts | Libraries | Articles" - is chosen, descriptions
of all new files and articles from the MQL4.com website are swapped automatically. Depending on the
current interface language, these files will be in certain language. It is important to remember that
program databases are different for different languages of the website. So, for example, you can find
something in the Russian version that you cannot find in the English version. And vice versa.
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On each page, you can sort the contents by column. There is the search engine to get a quick access to
the desired program. All pages are searched in simultaneously. It should be noted that the search is case-
sensifive. This means that "MACD" and "macd" are different words for the search engine.

fe Refresh %"Experts Indicators ; acripks -': Libraries ‘i\._ Articles * bownload '[a' ML, com

Mame Description [0 Aukhor
@ CloseonChart Quickly close open orders by dragaging and dropping this expert ... 2006... irusah 1
@ simple_cswafxk Simple csv-to-Fxt Corverter 2006... skringo
@ Rewvers Revers Scripk, 20086, .. Collectar
@ SkringArray3uitesam, . Demo of functions in SkringfrraySuite . mgh 2006, ., sx_ked

Surnnaty Repart In... | This scripk evaluates i into client ... sEringa

Dpen Enter

@ Raotaking text Easy example working odification ... 2006.., MekaQuokes
@ SkringsQuickSart Exarmple of file read a Download D 2006,,.  MetaQuokes
@ Trade Trade - script sending Refresh d order dat,,,  2006... MetaQuaokes
@ Close Close - script closing v Autodnangs A he list. 2006... MetaQuotes
@ Delete pending orde... | Delete pending order ) lisk pendin,.. | 2006,..) MetaQuokes
@ Modify Modify - script choosin G G rinting sel...  2006... MetaQuotes
@ Modify pending orde...  Modify pending arder - script choosing First in lisk pending order, ... 2006... MetaQuaokes
@ Send pending order,...  Send pending order - script sending SELL STOP pending order ... 2006... MetaQuotes
@ Period Converker IJse this script bo make own nonstandard timeframes, 2006,,. MetaQuokes
@ Trade Orders Histar...  This script takes orders From trade hiskory and places arrows on ... 2006, T-1000

Errors | Findin Files | Online Library | Help |
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Having selected the necessary program, you can open the website page where it is described or download
the code of this program. To view the program description, select the "Open" command in the context
menu. The program description will open in the "Help" tab of the "Toolbox" window. Double click on the
author's name will open page containing the author's personal details.
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¢ This script is For
MetaTrader 4
® Download MT4 - 2.4 Mb
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To load the desired indicator into the terminal, one has to download it previously. To do it, you can use the
"Download" button or select the corresponding command in the context menu. An MQ4 file will be saved
automatically in the corresponding folder of the Client Terminal ("\MetaTrader 4\experts\" or in one of its
subfolders). The code of the downloaded program will open in a separate window of MetaEditor.

Setup

Windows of "Toolbox" and "Navigator' can be arranged in various order at your will. You have just to point
the cursor onto the blue title bar of the window, press the left mouse button and drag the window to the
place you want. Windows can be moved not only within the main window of MetaEditor, but also drag
"outside". This can be helpful when working with several monitors simultaneously.
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